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LEGAL NOTICES 

 

Copyright 2012 © Impatica Inc.  All rights reserved Impatica for PowerPoint User’s Manual. 

The contents of this manual and associated Impatica for PowerPoint software are the property of Impatica 
Inc. and are copyrighted.   

All specifications, claims, features, representations and/or comparisons provided are correct to the best 
knowledge of Impatica as of the date of publication, but are subject to change without notice. 

INFORMATION IS PROVIDED BY IMPATICA ON AN “AS IS “ BASIS, WITHOUT ANY OTHER 
WARRANTIES OR CONDITIONS, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO, 
WARRANTIES OF MERCHANTABLE QUALITY, SATISFACTORY QUALITY, 
MERCHANTIBILITY OR FITNESS FOR A PARTICULAR PURPOSE.  IN NO EVENT SHALL 
IMPATICA INC. BE LIABLE FOR ANY LOSS OF REVENUE OR PROFIT OR ANY OTHER 
COMMERCIAL DAMAGE, INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL, 
CONSEQUENTIAL OR OTHER DAMAGES.  WE ARE ALSO NOT RESPONSIBLE FOR THE 
CLAIMS BY A THIRD PARTY.  OUR MAXIMUM AGGREGATE LIABILITY SHALL NOT EXCEED 
THIRTY DOLLARS CANADIAN ($30 CDN). 

PowerPoint and Windows XP/Vista/7 are trademarks of Microsoft Corporation. 

Adobe and Flash are either registered trademarks or trademarks of Adobe Systems Incorporated in the 
United States and/or other countries. 

The Java Impatica for PowerPoint runtime is distributed in Eastridge Technology’s Jshrink format. 
This software is based in part on the work of the Independent JPEG Group. 

This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/).  
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INTRODUCTION 

Impatica for PowerPoint converts PowerPoint presentations to HTML5 for delivery over the 
Internet to computers, tablets and smartphones.  

System Requirements 

• Windows XP, Vista or 7 

• PowerPoint 2007 or 2010 

Versions of PowerPoint Files Supported 

• Files created with PowerPoint 97 to 2011 

Impaticized Presentations 

PowerPoint Presentations that have been converted using Impatica for PowerPoint 5.0 or 
impaticized presentations can be uploaded to a web server then accessed using a web browser on 
virtually any computer, tablet or smartphone. Animations, fonts, graphics, audio and video will 
appear regardless of the device used to view the presentation.   

This is possible because: 

• Converted or impaticized presentations are stored in Impatica’s own format which is then 
displayed using Impatica’s player.  

• The player operates in HTML5 where it is available (on iOS, newer versions of Internet 
Explorer and Firefox, etc.) but falls back to using the Adobe Flash Player when 
necessary.  

• Impatica for PowerPoint automatically converts your presentation audio files into both 
.m4a audio files, which are required for certain environments (e.g., iOS, Internet Explorer 
and Safari) and .oga audio files, which are required for other HTML5 environments (e.g., 
Firefox) 

• Impatica for PowerPoint converts your .m4v or .mp4 videos to .ogv to ensure 
compatibility on all kinds of systems. 

Tour of an Impaticized Presentation 

An impaticized presentation plays in a web browser as it would have in PowerPoint, displaying 
graphics, text and animations, as well as playing audio and video and responding to mouse clicks. 
The presentation will automatically fill the browser area and will change size as the user resizes 
the browser window.  
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Below the slide area, a playback control strip is presented, giving the viewer control of the 
presentation. The set of controls included is specified in Impatica for PowerPoint before 
conversion.  

 
Figure 1 : Sample impaticized presentation 

 

The controls, from left to right, enable the viewers to: 

• Pause/play 

• Mute/unmute 

• Go to the first slide 

• Go to the previous slide 

• View the current slide number and jump to a particular slide: Clicking on the slide 
number in the playback control strip causes a dialog box to appear and allows the user to 
specify to which slide the presentation should switch. 

• Go to the next slide 

• View and change the current playback mode: The right-most playback control indicates 
whether the presentation is operating in HTML5 or Flash mode. Clicking on the badge 
causes a dialog box to appear, which provides information about the current mode and, in 
environments that support both HTML5 and Flash, enables the user to switch modes. 
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INSTALLATION 

Installing Impatica for PowerPoint 

To install Impatica for PowerPoint version 5, perform the following steps: 

1. If you have not already done so, download the latest Impatica for PowerPoint installer 
from: http://www.impatica.com/downloads/imp4ppt/latest/ 

2. Double-click the downloaded installer setup-imp4ppt-<version>.exe to initiate the 
installation process. 

3. Follow the installation instructions presented in the installer wizard until the installation 
is complete. 

 

Once the installation is complete, the Impatica for PowerPoint icon will 
appear on your desktop and in the Start menu.  

 

Registering Impatica for PowerPoint 

The first time that you launch Impatica for PowerPoint, you will be prompted to accept the 
software license agreement and enter valid Impatica for PowerPoint version 5 registration 
information before continuing. 

If you have already requested an evaluation license of Impatica for PowerPoint or have purchased 
the software, registration information has been sent to you via email. If you have not already 
obtained registration information, do so by going to one of the following pages: 

Free trial: http://www.impatica.com/store/request-imp4ppt.html 

Purchase: http://www.impatica.com/buy/imp4ppt/ 

Note: Evaluation copies of Impatica for PowerPoint are fully functional but place the banner 
“Evaluation only: www.impatica.com” through the center of the converted presentation. 

Registering Impatica for PowerPoint for the first time 

1. Launch Impatica for PowerPoint by double-clicking on the Impatica for PowerPoint icon 
on your desktop or selecting it in the Windows Start menu. 

2. In the window that appears carefully read the license agreement, then click I agree with 
the terms in this license agreement.  
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Figure 2: License Agreement and Software Registration 

	
  

3. In the Name, Organization and Registration Code fields, enter the information exactly as 
it was provided to you. To reduce potential errors, it is highly recommended that you 
copy and paste the information provided into these fields. 

4. Click OK to proceed to the main Impatica for PowerPoint application. 

Updating your Registration Information 

You may change your registration information at any time, for example to upgrade from an 
evaluation license to a purchased license. To do so, simply: 

1. Launch Impatica for PowerPoint. 

2. Click the Registration Code… button. 

3. In the Name, Organization and Registration Code fields, enter the information exactly as 
it was provided to you. To reduce potential errors, it is highly recommended that you 
copy and paste the information provided into these fields. 

4. Click OK to return to the main Impatica for PowerPoint window. 

Uninstalling Impatica for PowerPoint 

If at any time you wish to uninstall Impatica for PowerPoint, go to the Windows Start menu, click 
the Impatica for PowerPoint 5.0.7 folder and then select Uninstall Impatica for PowerPoint 5.0.7. 
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USING IMPATICA FOR POWERPOINT 

Overview 

Using Impatica for PowerPoint involves four basic steps: 

1. Add a PowerPoint file  

2. Click convert 
 

3. Wait for conversion to complete 
 

4. Preview the converted presentation  

These steps are independent for each file that you wish to convert. For example, you may add 
files while others are converting or being previewed.  

The following describes these steps in detail. 

Selecting Files to Convert 

There are three ways to add files to the list of presentations to convert: 

1. Drag and Drop onto the Impatica for PowerPoint Icon 

Before you launch Impatica for PowerPoint, drag and drop your file onto the 
Impatica for PowerPoint shortcut on your desktop. This will open Impatica for 
PowerPoint with your file listed. To launch the application with multiple 
PowerPoint files in the list, simply shift-click or ctrl-click multiple PowerPoint 
files then drag them onto the Impatica for PowerPoint icon. 

Note: This method works only when launching Impatica for PowerPoint and cannot be used to 
add files once it is already running. 

2. Click to Add PowerPoint files 

With Impatica for PowerPoint open, click in the area with the text Drag and drop PowerPoint 
files, or click to add.  An open dialog will appear from which you can select your PowerPoint 
presentation. 

 

 

Figure 3: Area to click to add PowerPoint files 
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3. Drag and Drop onto the Impatica for PowerPoint Window 

Once Impatica for PowerPoint is open, you can drag and drop files onto PowerPoint file list 
(highlighted below) to add them. You may drag and drop one file at a time or multiple files at 
once. 

 
Figure 4: Area to drag and drop PowerPoint files 
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Choosing Conversion Settings 

For each file that you wish to convert, you can choose to modify the conversion settings. The 
following table describes each of the available settings: 

 
Table 1: Conversion Settings in Impatica for PowerPoint 

Setting Description 

Source The full path to the file to be converted (cannot be changed) 

Save To 
The folder in which the output is to be saved. Click Browse… to 
specify another location or click Source Folder to save the output 
in the same folder as the original PowerPoint file. 

Include Playback Controls  

Pause/play button Indicates whether the pause/play button will appear in the 
converted presentation 

Mute button Indicates whether the mute button will appear in the converted 
presentation 

Pause/play button Indicates whether the pause/play button will appear in the 
converted presentation 

First slide button Indicates whether the button that enables users to jump to the first 
slide will appear in the converted presentation 

Previous slide button Indicates whether the button that enables users to jump to the 
previous slide will appear in the converted presentation 

Slide numbers 

Indicates whether the current and total slide numbers (in the 
format 1/100) will appear in the converted presentation. If it does 
appear, users will also have the ability to click the slide number 
and enter any slide to which they wish to jump. 

Next slide button Indicates whether the button that enables users to jump to the next 
slide will appear in the converted presentation 

Wait for sound at end of 
animation 

When checked, the player will ensure that each animation does 
not automatically advance until any sound that is set to play with 
the animation has played completely. This is useful for perfectly 
synchronizing bullet points, for example, with audio. 

When unchecked, the player will automatically advance 
animations according to the settings in PowerPoint. 
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Setting Description 

Wait for sound at end of 
slide 

When checked, the player will ensure that each slide does not 
automatically advance until any sound that is on it has finished 
playing. This ensures synchronization of narration and slides on 
every viewing platform.  

When unchecked, the player will automatically advance slides 
according to the settings in PowerPoint.  

Make all animations 
automatic 

When checked, the presentation will automatically display 
animations that are set to appear only on click. Since viewers may 
not know to click through slides to reveal all of the animations, 
this option is an easy way to convert a presentation that was 
designed for live, stand-up presentations into presentations 
suitable for online viewing.  

When unchecked, the player will display the presentation as 
specified in PowerPoint and animations set to appear on click will 
appear only once the person viewing the presentation clicks. 

Export notes to an HTML 
file 

When checked an HTML file containing the slide titles and notes 
of the entire presentation is generated. 

Export notes to a text file When checked a text file containing the slide titles and notes of 
the entire presentation is generated. 

Generate zip package 

When checked, the converted presentation will also be 
compressed into a single zip file. This option can be used to 
simplify uploading converted presentations to Learning 
Management Systems (LMS) that allow users to upload zip files 
then unzip them on the server once the upload is complete. 

Convert video to Theora 
for Firefox (.ogv for 
Mozilla mode) 

When checked the Impatica for PowerPoint converter will 
automatically generate a .ogv video file for each .mp4 or .m4v 
encountered. For more details refer to the section Working with 
Video. It is recommended that this option remain checked unless 
your presentations will be viewed exclusively non-Mozilla 
browsers or you intend to supply your own .ogv files. 

Copy linked files to output 
folder 

When it is checked, any local files to which the PowerPoint file 
links will be copied into the top level of the output folder and 
links in the converted presentation will point to the files in the 
output folder. When it is unchecked, files will not be copied into 
the output folder and hyperlinks in the converted presentation will 
remain unchanged from the original. It is recommended to 
uncheck this setting if the links in the source presentation refer to 
files on the server outside of the presentation folder. 
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Setting Description 

Open hyperlinks in: 

When set to New Window, all of the hyperlinks in the 
presentation will open in a new browser window or tab 
(depending on the browser).  

When set to Current Window, all of the hyperlinks in the 
presentation will open in the current browser window, replacing 
the presentation. 

When set to Custom, click the Edit button to specify the behavior 
for each individual hyperlink in the presentation. In the dialog 
box that appears you can also save your custom hyperlink settings 
to a new PowerPoint file. When you choose to convert a 
presentation to which the custom hyperlink settings have been 
saved, the settings will be restored when you choose the Custom 
option.   

Apply to All Applies the current settings to all of the files in the list that have 
not yet been converted. 

Save as Default 
Saves the current settings as the default so that they are applied to 
any files added to the list after clicking the button or in future 
sessions of Impatica for PowerPoint. 
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Converting your Presentation 
	
  

Once your PowerPoint file has been added and you are satisfied with the conversion 
settings, click the convert button to initiate the conversion of your presentation. 

 

 
Figure 5: PowerPoint file ready to be converted in Impatica for PowerPoint 

 

If no other files are currently converting, the file will begin to convert immediately. 
Otherwise, conversion will begin as soon as the converter becomes available. 
Conversion occurs in three phases: first slides are converted then audio (if any) and 

finally video (if any).  
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Figure 6: File that has finished conversion in Impatica for PowerPoint 

Once conversion is complete, the Preview  button will appear. As well, one or more of the 
following indicators will appear in the conversion settings area: 

 
The Conversion Info Indicator will always appear when conversion is complete. Point 
to it to see how many slides were converted as well as the amount of time spent 
converting your presentation.  

 
The Video Indicator will appear if video was detected in your presentation and will 
present the number of videos encountered. Click on this icon to launch a web page that 
will include links to test that the necessary videos are in your output folder. 

 
The Error Indicator will appear only if a serious error was encountered during 
conversion. Point to it to obtain a description of the error(s) encountered. 

 
The Warning Indicator will appear only if a non-fatal issue was encountered during 
conversion (for example, if a certain font used in the presentation could not be found). 
Point to it to view a description of any warnings that were encountered. 
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Previewing your Presentation 

With your presentation successfully converted, you may proceed with previewing 
it. Impatica for PowerPoint version 5 includes a simple web server for previewing 
presentations. 

To view your presentation on the same computer that is running Impatica for PowerPoint: 

1. Click the preview button. 

2. Choose the Open with menu item that corresponds to the web browser you would like 
to use. 

3. View your presentation in the window that appears. 

Once you have started the preview sever, the address to access the presentation hosted on the 
preview server will appear next to the preview button. 
	
  

	
  
Figure 7: File with preview server started 

	
  

Changing the Preview URL 

Internally, your computer can refer to itself as localhost, while on your internal network, your 
computer can be referenced using one or more assigned IP addresses. Therefore, to preview your 
presentation on other computers or devices on your network, Impatica for PowerPoint offers the 
shortcut of creating a suitable preview URL for you.  

To include your computer’s IP address in the preview URL instead of localhost: 

1. Click on the Preview button. 

2. From the menu that appears, choose the IP address that you wish to use. 

3. If you have not already started your preview server, click on the Preview button again 
and choose either Start Preview Server without Opening Browser or one of the Open 
with menu items.  

4. The URL using your selected IP address will now appear next to the Preview button. 
It will also be used when previewing in a browser. 

Starting the Preview Server without Opening a Browser 

You may wish to start the preview server without launching the presentation on your current 
system. For example, if you wish to only test your presentation on an iPad, opening the 
presentation on your Windows computer may not be desirable. In this instance, once you have 
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completed conversion of your presentation, click on the Preview button then select Start Preview 
Server without Opening Browser. This will launch the preview server but will not open the 
presentation on your Windows computer. It is now accessible on other devices with access to 
your PC on your local area network. 

Previewing on Other Devices 

With Impatica for PowerPoint, it is easy to preview your newly converted presentation on devices 
other than the Windows PC you are using with Impatica for PowerPoint. To do this, simply: 

1. Convert your presentation. 

2. Click on the Preview button and ensure that an IP address other than localhost is 
selected. 

3. Click on the Preview button and choose either Start Preview without Opening 
Browser or one of the Open with options.  

4. In the web browser on the test device, enter the URL that appears next to the Preview 
button.  

5. View the presentation on the device. 

Note: Some Windows firewall settings may restrict access to the presentation hosted on your 
Windows computer, even from devices on your local area network. Should you encounter this 
situation, please modify your firewall settings to allow access or speak with your computer 
administrator for further assistance. 

Previewing Previously Converted Presentations 

To properly play converted presentations, a web server is required. Since Impatica for 
PowerPoint includes a simple web server for previewing presentations, it can be used to play 
presentations that were previously converted by Impatica for PowerPoint version 5.   

To preview a presentation that was previously converted: 

1. Ensure Impatica for PowerPoint is running. 

2. Either:  

• Click and drag the output folder for the converted presentation or the index.html 
file within the output folder onto the Impatica for PowerPoint file list;  

OR 

• Click the Drag and drop PowerPoint files, or click to add area. In the dialog box 
that appears select the index.html within the presentation output folder. 

3. Click on the preview button for the previously converted presentation. 
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Working with Audio 

With Impatica for PowerPoint, audio included in your PowerPoint presentation will automatically 
be converted and included in your impaticized presentation. 

Audio Requirements 

It is recommended that you use audio that meets the following specifications: 
	
  

File type WAV 

Encoding PCM 

Sampling Rate 8000 Hz (8 kHz) 

PowerPoint offers a number of ways to insert audio, all of which are supported by Impatica for 
PowerPoint: 

Add your audio to your slide transition 

In PowerPoint 2007:  

1. On the Animations tab, click on the Transition Sound combo box 

2. Select Other Sound…  

3. Navigate to your audio file and click Open. 

In PowerPoint 2010: 

1. On the Transitions tab, click on the Sound combo box. 

2. Select Other Sound… 

3. Navigate to your audio file and click Open. 

 

 

TIP:  Save time and synchronize perfectly 

To save time and ensure perfect synchronization of your presentation on all 
devices, in PowerPoint choose Advance slide Automatically After but don’t worry 
about setting the time. Then, in Impatica for PowerPoint, select the conversion 
setting Wait for sound at end of slide. The Impatica player will display your slide 
for the duration of the audio and will then advance to the next slide. 
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Add audio to your animation effect 

In PowerPoint 2007: 

1. Select the object that you wish to animate. 

2. On the Animations tab, click Custom Animation. 

3. In the panel that appears, click Add Effect and select the animation effect. 

4. In the list of animations, click the arrow next to the animation you just added to pop-up 
the animation options menu. 

5. Click on Effect Options. 

6. With the Effect tab selected, click on the Sound combo box then scroll to and click on 
Other Sound… 

7. Navigate to your audio file and click Open. 

In PowerPoint 2010: 

1. Click on the object you wish to animate. 

2. On the Animations tab, click Add Animation and select the desired effect. 

3. In the Animation group, click the arrow button in the bottom-right corner to see 
additional effect options. 

4. In the dialog box that appears, in the Effects tab, click on the Sound combo box. 

5. Select Other Sound… 

6. Navigate to your audio file and click Open. 

 

 

TIP: Synchronize audio with bullets and other effects 

If your slide builds with animation effects, such as bullets, and you would like to 
ensure that the animations appear at precisely the right time in the narration, add 
each audio clip to each animation. Then, when converting with Impatica for 
PowerPoint, choose the Wait for sound at end of animation checkbox. This will 
guarantee that the audio for the current animation plays entirely before the next 
animation automatically appears. In doing so, you will not only save time making 
your presentation but you will also ensure perfect synchronization on every 
device. 
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Insert Sound 

In PowerPoint 2007: 

1. On the Insert tab, click Sound. 

2. In the dialog box that appears, navigate to your audio file and click Open. 

3. When prompted, choose to have your audio start either Automatically or When 
Clicked. 

In PowerPoint 2010: 

1. On the Insert tab click Audio. 

2. Navigate to your audio file and click Insert. 

Record Narration 

In PowerPoint 2007: 

1. On the Slide Show tab, click Record Narration. 

2. Click OK. 

3. As you advance through your presentation, narrate your slides. PowerPoint will record, 
save and insert your audio for you. 

4. When the presentation is over, you will be prompted to save your slide timings. Click 
either Save or Don’t Save.  

 

 

TIP: Synchronize narration precisely 

You can choose Don’t Save for slide timings. Just ensure that all of your slides 
are set to advance automatically. Then, in Impatica for PowerPoint, select the 
conversion setting Wait for sound at end of slide. This will ensure that your slides 
are perfectly synchronized with your narration regardless of the device or Internet 
connection used to view your presentation. 

In PowerPoint 2010: 

1. On the Slide Show tab click Record Slide Show. 

2. In the dialog box that appears, ensure that the option Narrations and laser pointer is 
selected. 

3. Click Start Recording. 

4. As you advance through your presentation, narrate your slides. PowerPoint will record, 
save and insert your audio for you. 
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Working with Video 

In order to function across all kinds of browsers, your converted presentation must include each 
video in two formats: .m4v to support iOS devices and browsers such as Internet Explorer and 
Safari, while .ogv files are required for playback in Mozilla Firefox. Impatica for PowerPoint 
requires that you provide video in MPEG-4 format and it will convert this video to produce a 
corresponding .ogv video file. 

Video Requirements 

To be converted by Impatica for PowerPoint, videos must be linked and must be provided in the 
following format: 

 
Table 2: Video Requirements for Impatica for PowerPoint 5.0 

File type .mp4 or .m4v 

Video format H.264 Baseline Profile Level 3.0 (or 3.1 only on newer devices) 

Video size maximum 1280x960 at up to a total bit rate of 4540 kbps 
(Apple recommends 400 x 224 for 16:9 and 400 x 300 for 4:3, 
not more than 440 kbps, depending on target network 
connection) 

Audio format AAC-LC up to 48 kHz, stereo audio (up to 160 kbps, typically 
32 kbps for lower sampling rates) 

 

Videos may be supplied in either of the following two manners, either: 

• Insert the .mp4v or .mp4 video file into the desired PowerPoint slide.  
 
In PowerPoint 2007:  

1. On the Insert tab, click Movie then choose Movie from file… 

2.  Navigate to your .m4v or .mp4 video file and click Open.  

In PowerPoint 2010: 

1. On the Insert tab, select Video then choose Video from File… 

2. Navigate to your video file and click on the small arrow on the Insert button. 

3. Click on Link to File. 

or 
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• Provide a .mp4 or .m4v copy of a video already inserted into your presentation.  
 
If you have an existing PowerPoint file that contains a video in a different file format 
(e.g., .avi), simply provide a .mp4 or .m4v copy of the movie with the same file name in 
either the same folder as the original video or in the same folder as the PowerPoint file.  

For example, if your presentation contains a movie named “MySampleMovie.avi” then 
simply place a copy of the video that meets the above requirements, e.g., 
“MySampleMovie.mp4” in the same folder as “MySampleMovie.avi” or in the same 
folder as the PowerPoint file. 

Producing Acceptable Video Files 

There are a number of software tools that can be used to convert videos into .mp4 or .m4v files 
that meet the requirements given above.  

FFmpeg (http://ffmpeg.org) is an example of a free application that can be used to create these 
files. Ensure that you read their software license agreement and legal  information to determine if 
your use falls within the permissible use of their software. 

The following is an example of ffmpeg parameters that can be used to achieve suitable encoding 
(where the items yourInputFileName, yourDesiredVideoBitRat, yourDesiredVideoFrameRate and 
yourDesiredOutputFilename must be filled in with values suitable for your video): 

-i yourInputFileName –r yourDesiredVideoBitRate –s yourDesiredVideoFrameSize 
yourDesiredOutputFilename -async 2 -acodec libfaac -ab 32k -vcodec libx264 -b 
480k -flags +loop+mv4 -cmp +chroma -partitions +parti4x4+partp8x8+partb8x8 -
subq 7 -trellis 1 -refs 5 -coder 1 -me_range 16 -g 250 -keyint_min 25 -
sc_threshold 40 -i_qfactor 0.71 -qdiff 4 -threads 0 -ac 1 -bt 256k -maxrate 
10000k -level 31  

Video Conversion 

Impatica for PowerPoint will automatically convert all videos provided in the specified format to 
.ogv files. To disable this conversion, you may de-select the Convert video to Theora for Firefox 
(.ogv for Mozilla mode) conversion setting. It is highly recommended that this option be 
deselected strictly if your presentation is to be delivered only to specific non-Firefox 
environments (e.g., only to the iPad) or if you have video in .ogv format that you would like to 
provide after conversion by copying it into the output folder. 

Once conversion of a PowerPoint presentation containing videos is complete, the video 
indicator will appear in the Conversion Settings area. A number indicating the total number 

of videos encountered during conversion will be displayed. By clicking on this indicator you can 
open a video list in a web browser. Then, by clicking on each link in the list, you can ensure that 
all of the required videos are in the output folder. Be sure to test the links in the column that 
corresponds to the browser in which you are viewing the video list. 
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Working with Linked Files 

Impatica for PowerPoint will maintain any hyperlinks in your presentation that link to other files 
such as PDF files or other Office documents. To work effectively with these types of links please 
keep the following in mind: 

• Files that are linked to from your PowerPoint presentation will be copied into the 
conversion output folder so that the output contains everything for properly viewing the 
presentation. 

• Ensure that the file to which you are linking is either in its original location or in the same 
folder as the PowerPoint file so that Impatica for PowerPoint can find it during 
conversion. 

• Each browser handles links to files differently. If you are concerned about how links to 
your files will be handled, ensure that you test the links in your converted presentation. 

• Be sure to test all of the links in your converted presentation to verify that they are all 
working before and after publishing to your server.  
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PUBLISHING YOUR PRESENTATION 

Once your presentation has been converted and previewed, it is ready to be published to a web 
server or Learning Management System. In order to successfully upload your presentation, ensure 
that you: 

1. Verify that your server meets the Server Requirements specified below. 

2. Include all of the files generated by Impatica for PowerPoint. 

Server Requirements 

• Partial Content Requests 
HTML5 audio and video playback (i.e., on iPad) requires that the chosen web server 
properly support Partial Content Request capability as defined by the HTTP 1.1 standard. 
You would find that nearly all modern web servers support this. However, it is important 
to mention this since it is possible that other layers on the server, such as the LMS 
software layer, could have an effect on this level of compatibility. For HTML5 web based 
video playback on the iPad, this feature is mandatory, regardless of the overall solution 
being used.  

• MIME Types 
For audio and video playback, the server will need to have the appropriate standard 
MIME type settings for audio and video files as follows: 

 
Table 3: MIME types required 

# MIME type Extension 

audio/mp4 m4a 

video/mp4 m4v 

audio/ogg oga 

video/ogg ogv 

Required Files 

When uploading your converted presentation to a server, it is important that all of the files 
generated by Impatica for PowerPoint are included. The following is an overview of the files 
generated by Impatica for PowerPoint and therefore required when you publish your presentation. 

During conversion, Impatica for PowerPoint will generate an output folder as specified by your 
Save To conversion setting. In the example below, the Save To location was “Intro-Presentation”.  



IMPATICA FOR POWERPOINT 5.0 USER MANUAL 21 

In order to properly play your presentation from your server, the enitre contents of your output 
folder must be uploaded to your server, maintaining the original folder structure. 

 
Figure 8: Contents of output folder after conversion 

 
Table 4: Description of files created by Impatica for PowerPoint 

File/Folder Description 

imcontent-* The imcontent folder contains the impaticized presentation data 
as well as all of the images and audio files required for your 
presentation. 

implayer This folder contains the player which is responsible for 
displaying your presentation. 

index.gif An image required by index.html. 

index.html The web page used to display the presentation. 

index.nocache.js A JavaScript used to ensure that no cacheing problems occur 
between presentations. 

index.png An image required by index.html  

Video and other files Any videos used in your presentation and any files that your 
presentation links to will also be at the root of the output folder. 
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SUPPORTED POWERPOINT FEATURES 

The following table provides an overview of the PowerPoint features supported by Impatica for 
PowerPoint 5.0 

 
Table 5: Supported PowerPoint features 

Feature Notes 

Slide Sizes The aspect ratio of the slide size specified in PowerPoint is retained. At 
playback, the maximum size possible that fits within the browser 
window and retains the aspect ratio will be used. 

Slide Masters All are supported 

Slide Layouts All are supported 

Backgrounds All are supported 

Text All are supported 

Graphics All are supported 

WordArt All are supported 

SmartArt All are supported 

Charts All are supported 

Shapes All are supported 

Video Videos supplied as .mp4 or .m4v are supported, following the 
information provided in the section Working with Video. 

Audio Refer to the section Working with Audio for tips. 

Audio/Video 
playback options 

The following options are unsupported: while playing pause slide 
show/continue slide show, stop playing after current slide or ___ slides, 
loop until stopped, play movie across slides, rewinding movie after 
playing, hide during show, play full screen, and picture effects applied to 
video. 
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Feature Notes 

Animations Charts, SmartArt and text that is formatted with special effects will be 
animated as a single object. 

Animations triggered by clicking on an object are not supported. 

The following effects will be substituted with another effect: Bold 
reveal, Bold flash, Change font size, Change font style, Change font, 
Checkerboard,  Flip, Grow with color, Light Speed, Peak in/out, 
Random effects, Strips, Style emphasis and Change font color 

The following options are currently unsupported: Dim or change color 
after animation, hide on next mouse click, repeat until end of slide or 
until next click, smooth start and end and text by word or letter 

Transition Effects The following effects are substituted with other effects: News flash, 
random, strips 

Action Settings and 
Hyperlinks 

Supported: Hyperlinks to next slide, previous slide, first slide, last slide, 
specific slide of the current presentation, URL, e-mail address and other 
file 

Not Supported: Hyperlinks to other presentations, last slide viewed, 
custom show, end show, object action, run program and run macro  

Actions on mouse over are not currently supported. 

Hyperlinks to slides that are hidden are not currently supported. 

Slide Advance All combinations of Automatically after __ seconds and advance on 
mouse click are supported. 

Hidden Slides Hidden slides are omitted from the converted presentation, so hyperlinks 
to hidden slides are not currently supported. 
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CUSTOMER SUPPORT 

A complimentary 90 days of e-mail and telephone customer support are included with your 
purchase of Impatica for PowerPoint. Extended support plans are also available. 

Should you require customer support, please contact us by e-mail or telephone.  Our support staff 
is available 8:30 am to 5:00 pm Eastern Time. 

E-mail: support@impatica.com 

Phone: (800) 548-3475  or  +1 613 736-9982 

Web: http://www.impatica.com 


